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Computer fundamentals
Necessary hardware

CPU
The central processing unit is at the heart of all computers. It is the 

computer. It’s based around a single chip worth about $6.
Monitor (number of colors)

8-bit color displays 256 colors 
16-bit color displays thousands of colors (65,536)
24-bit color displays millions of colors (16,772,216) eight bits for each 

pixel component of RGB
Input

Flatbed
Negative (save on print-processing costs)
Digital cameras

Mass-storage device
Iomega Zip :less capital investment, less per cartridge; very common 

(100MB  per cartridge)
Iomega Jaz (1GB per cartridge)
Magneto-Optical: more capital investment, less per cartridge
Compact Disc (CD) or DVD
Some sort of mass storage device is a necessity; floppies don’t cut it

Printer (300dpi to over 3000dpi)
Output to film for true photographic quality

The graphical interface
Hierarchical File System (HFS)

Review how to navigate through this system
Talk about having multiple programs open at the same time
Define a window and its characteristics
Define a dialog box and its characteristics

The File menu: New, Open, Close, Save, Print, Quit
EXERCISE: Open a file using the HFS

Draw special attention to Save
Discuss file formats: TIFF, EPS, GIF, PICT, JPEG, Photoshop

The Edit menu: Undo, Cut, Copy, Paste
Draw special attention to Undo

Look at other menus in menu bar
Image, Layer, Select, Filter, View, Window, Help
You can hide all these things by pressing the Tab key; good time to 

discuss viewing the screen in different ways at the bottom of the 
Toolbox

Memory allocation (RAM and ROM)
Show About This Macintosh… under Apple menu
One of the most important components is the Random Access Memory 

(or RAM); you can never have enough RAM
The RAM is the working memory of the computer; it’s measured in 

megabytes. Photoshop requires at least 16MB to run efficiently; 
256MB is not too much.

Memory is required for the image, undo operations, the snapshot, the 
clipboard and filters; 3x-5x the image size is needed to function 
efficiently

If there’s not enough RAM, PS goes to virtual memory
Get Info; give PS all the RAM you can; RAM is probably the best 

single investment you can make to improve the efficiency of your 
computer

Scratch disk should be fast, large, clean, defragmented
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Control Panels
ATM font cache 384K or more for working with type
Memory Control Panel: disk cache as low as possible; virtual memory 

OFF; 32-bit addressing ON; RAM disk off

Photoshop fundamentals
Types of graphics programs

Paint
examples: SuperPaint, MacPaint, Photoshop
generally refers to 72dpi programs that edit the image by pixels; 

Photoshop is a high-resolution bit-map editing program that can 
edit images in many resolutions; higher resolution images require 
more memory

EXERCISE: Option-click on K value in lower-left corner of image; 
notice resolution

EXERCISE: new document 1 inch by 1 inch, 72 ppi resolution, gray-
scale

Draw
examples: Adobe Illustrator, Macromedia FreeHand
refers to programs that edit the image based on lines and curves, not 

pixels. These lines and curves can be layered and changed with-
out affecting the rest of the image

Pixels, lines and dots
Pixel (PPI)

Photoshop deals in pixels (picture elements); the pixel is the smallest 
unit of an image; on the display screen, it is assigned a hue, a 
saturation and a lightness; PPI=LPI x 2

EXERCISE: squiggle in the middle of a small page with the Paint 
Brush enlarge it using the Magnifying Glass (Command +, Com-
mand  –, double-click on Hand tool, double-click on magnifying 
glass)

Lines per inch (LPI)
This is the traditional screen frequency we are used to seeing in print-

ing; newspapers print at about 85 LPI; magazines at 133LPI 
or greater; it’s really a function of what frequency the press can 
handle; max LPI = 10% x DPI resolution of printer

Dots per inch (DPI)
A dot is the smallest unit of printed output; dot-matrix printers output 

at 72 dpi; laser printers at 300-600 dpi; imagesetters at 1000 dpi 
or greater

Preferences
General

Color Picker (use Photoshop’s)
Interpolation (the way Photoshop determines what color pixel goes 

between two pixels when an image is resized) (use Bucubic; it’s 
the best looking but also relatively slow) (Nearest Neighbor is 
rough, but it’s very fast)

Display
EXERCISE: double-click on eraser to erase entire image. Draw a line 

with anti-aliasing on and one with it off; notice how PS tries to 
make line blend to background.

BRUSHES
With the brushes palette, you can select brush 
shapes and, often more importantly, affect 
aspects of the Pencil, Airbrush, Rubber Stamp, 
Line tool, Type tool, Paint Bucket, Gradient 
tool, Smudge, Blur, Sharpen, Dodge and Burn 
tools

SHOW INFO
This window shows the position of the mouse 
and the color under the mouse pointer. It also 
shows the change in position of a moved 
element and angle of rotation. Depending 
on the tool and object selected, it can also 
show a selection’s dimensions and distance 
between two points.
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File Handling
Display and cursors
Transparency and gamut
Units and rulers
Guides, grid & slices
Plug-ins and scratch disk

Determines where virtual memory is used; any disk in the SCSI chain

Tools, palettes and rulers
Displaying (vs. not displaying)

Reminder that Tab key toggles
The Toolbox

Review the names of each tool
Brushes palette: options

Bring up the brushes palette and show how to select a brush
Discuss how this palette affects the other creation tools as well
Show how to create a custom brush

Colors palette: picker, swatches, scratch
Bring up the colors palette and show how to change the foreground/

background color in various modes
Channels palette: layers, channels, paths

Call up an image in RGB and show the various images; edit the pref-
erences to show them in color to bring out the effect

Info palette
EXERCISE: select something with the Lasso tool and notice how the 

Info Palette changes. Click inside this area, hold and drag and 
notice how it changes.

History palette
Sort of like unlimited undos; note History Brush

Action palette
Record repetitive actions (good for resizing a bunch of photos)

File Browser
A start at managing hundreds of files; still not as good as commercial 

software such as Photo Mechanic

Editing modes
Grayscale

256 levels of gray approximate those in a continuous tone image
CMYK (cyan, magenta, yellow, black; for printing)

Subtractive color (sum of all color = black)
EXERCISE: finger-painting

RGB (red, green, blue; for display and Web pages)
Additive color (sum of all colors = white)
EXERCISE: create the same color using the color palette mixing RGB 

which is really the only method the monitor can display (plus it’s 
only three channels)

Lab 
Lightness, a, b
approximates vision; standard

Duotone
A specific mode with specialized uses
Discuss Pantone colors in Color Picker

COLOR PICKER AND SWATCHES
The color palettes show the colors with which 
you are working. They also allows you to 
select other colors which you can apply to the 
image. They works in Grayscale, Lab, RGB, 
HSB, and CMYK modes.

PICTURE BROWSER
In an effort to help users manage files, Adobe 
added the Picture Browser with Photoshop 
7. In this browser, Photoshop displays 
thumbnails of any images in a given folder. 
With digital camera files, it also shows 
the information from the camera including 
aperture and shutter speed.
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Image-creation tools
Here’s a good chance to show how to open a New Window (Window) 

for viewing in one window and editing in another
Foreground/Background

Just a reminder of what the foreground and background is
EXERCISE: Lasso something, cut it; notice how the background color 

shows through
Note that Option-Delete replaces a deleted item with the Foreground 

color
Airbrush

Notice how holding down the clicker puddles the “ink”
Brush

Discuss opacity
Double-click options include fade out and pressure
EXERCISE: create a brush and paint something or work on already 

open image
With Eyedropper, notice the color values with the Color Palette open

Selecting brushes
Double click to bring up Paintbrush options

Eraser
Holding down the Option key brings up the Magic Eraser which 

reverts to SAVED image
Pencil (under Brush)

Edits pixel by pixel
NOT aliased

Line
Holding down the Shift key draws a straight line
Double-clicking allows you to change the width

Gradient
Works on a selected area from foreground to background
Double-click on Gradient Tool to select Style, Type, etc.
EXERCISE: draw a gradient style over the entire image with opacity 

at 25%
Paint Bucket (under Gradient)
Painting Modes

Normal: foreground covers underlying pixels
Dissolve: changes pixels to make it the result in a random fashion 

depending on the opacity of any given pixel
Behind: changes pixel to make it the result color; like painting on the 

back of the transparent areas in a sheet of acetate
Clear: Changes each pixel and makes it transparent
Darken: only pixels lighter than foreground are changed
Multiply: darkens the image by multiplying the color values according 

to a mathematical formula
Color burn: looks at the color information in each channel and dark-

ens the base color to reflect the blend color. Blending with white 
produces no change.

Linear Burn
Lighten: only pixels darker than foreground are changed
Screen: lighten the pixels being painted over while giving them the tint 

of the foreground (opposite of Multiply)
Color dodge: looks at the color information in each channel and 

brightens the base color to reflect the blend color. Blending with 
black produces no change.

Linear Dodge
Overlay: multiplies or screens the colors depending on base color; the 

base color is mixed with the blend
Soft light: darkens or lightens the colors depending on the blend color

Original images

Manipulated images
Artwork by Daniel Weisbeck,
Taylor Publishing Co., Dallas, TX

NEW VERSION
In Photoshop 4 for the 
first time, several of the 
tools expanded to reveal 
more tools. The Cropping 
tool was hidden 
under the Rectangular 
Marquee. Fortunately, 
version 6 brought the 
cropping tool back to 
the top. 



4  Digital Imaging in Adobe Photoshop • By Bradley Wilson ©2002 ©2002 By Bradley Wilson •  Digital Imaging in Adobe Photoshop  5

Hard light: multiplies or screens colors depending on the blend color
Vivid Light
Linear Light
Pin Light
Difference: subtracts either the blend color from the base color or the 

base color from the blend color depending on which has greater 
brightness value

Exclusion: creates an effect similar to but softer than the Difference 
mode. Blending with white inverts the base color values. Blending 
with black produces no change.

Hue: painted over pixels changes to that of the foreground color
Saturation: painting changes the saturation of the underlying pixels, 

but leaves their H and L alone
Color: changes pixels to foreground color; H/S changed, but not lumi-

nosity
Luminosity: affects only the lightness, not color values

Type
Remind them of ATM font cache
Notice how font becomes “pixelated”; it’s part of a TIFF image now
Vertical Type
Type Mask

Editing
Cut, Copy and Paste
Hand

Double-click allows you to fill screen with largest possible window (at 
an even size)

Zoom
Double-click brings image to 1:1

Clone
Double-click on the Clone Stamp Tool to bring up Options
EXERCISE: clone something
EXERCISE: repair a damanged photo

Cropping
Double-click allows you to specify a final size
Crop part of an image and click with scissors inside the image; canvas 

size changes; image size does NOT
Cropping can also be done with the rectangular marquee tool

Dodge/Burn
Just like in the darkroom
EXERCISE: On a grayscale image do some dodging and burning

Smudge, Sharpen and Blur
Locally blur or sharpen an image
Effectively, blur lowers the contrast of the affected pixels
Holding down the Option key brings Sharpen (sharp edge)

Healing Brush Tool/Patch Tool
EXERCISE: "Heal" a photo

The Eyedropper
Hold down the clicker and notice how the color under the Eyedropper 

changes as it’s moved around
Double-click on Eyedropper to bring up sampling options

Channels and Layers
Remind them of four-color channels and view each one in grayscale
Create some things in different channels and load them for effects
Discuss layers
EXERCISE: From Wow book

CHANNELS PALETTE
The channels palette allows you to work in 
only one portion of an image, the yellow 
portion, for example. Multiple channels 
are copies of the image and can take up a 
considerable amount of space. 

LAYERS PALETTE
Like working in most draw programs, 
Photoshop allows you to work on individual 
layers without affecting the rest of the image.

COLOR PICKER
The color picker shows any given color in the 
four primary editing modes, HSB, RGB, Lab 
and CMYK. When you select a radio button, 
the two-dimensional display on the left shows 
the other two functions. For example, if 
you pick Hue (as above), the display shows 
saturation (x) and brightness (y).
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KNOCK OUTS
To separate an object from the background, 
create a clipping path. First define the path 
using the Pen tool. Save that path as a 
clipping path. Although a bit time-consuming 
and tedious on complicated images, this 
provides a flexible image that can be placed 
on a variety of backgrounds.

Making Selections
Command-A for Select All; Command-D for Deselect All
Shift adds; Command takes away

Marquee
Show clear, fill under Edit menu, show marquee options

Lasso tool
Holding down the Option key allows a “connect the dot” effect

Magic Wand
The most powerful selection tool; notice “Similar” under the Select 

menu
Double-click for tolerance

Masking
Use Quick Mask mode as a selection device; very powerful

The Select menu
Select all or none
Make note of Inverse which is useful when one area of an image can 

be grabbed but you want the other portion
The importance of Grow
EXERCISE: Set tolerance at 1, magnify image until you can see indi-

vidual pixels; click on one pixel and select similar from the Select 
image.

EXERCISE: Experiment with various items under the Select menu
Pen tool and paths

Discuss bezier curves
EXERCISE: Create a path and turn it into a selection
EXERCISE: Create a selection and turn it into a path
EXERCISE: Create a clipping path which PageMaker and QuarkX-

Press require to keep edges smooth

Combining images
Paste from one image into another image
Paste inside a selected area
Fill with pattern
Quick Mask and gradient

Image menu
Adjustments

Levels
Pay particular attention to the highlights, shadow areas and midtones

Curves
Edit the curve paying particular attention to the highlights, shadows 

and the midpoint
EXERCISE: Add some points and invert the curves

Color Balance
Brightness/Contrast

EXERCISE: With image open, play with brightness and contrast; pay 
particular attention to the difference; analogy: brightness is af-
fected by time of the exposure; contrast is affected by filters when 
printing

Hue/Saturation
Replace Color
Invert

Command I is keyboard shortcut
Equalize
Threshold
Posterize

Once a popular yearbook effect

PATHS
Paths are useful for separating an object 
from the background or combining images. 
Since the path can be saved and easily 
manipulated, it has some advantages over 
other methods of selecting an area.
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Variations
This is a fast way to get some modifications of an image; very power-

ful
Calculations…
Image Size

Changing this means adding information (interpolation) or deleting 
information

Canvas Size
A good way to add borders

Rotate canvas
Done in terms of clockwise, etc.
Flipping image on a horizontal or vertical axis
It’s better to do this kind of thing BEFORE bringing it into PageMaker 

or QuarkXPress because it takes less memory
Liquify

A great way to mess up good photos.

Layer menu
New 
Duplicate Layer…
Delete
Layer styles

Drop Shadow, Inner Shadow, Outer Glow,  Inner Glow, Bevel and 
Emboss, Satin

Type
 Warp Text
Rasterize
Flatten image

View menu
CMYK preview
Gamut warning
Guides
Rulers

Filters (the “fun” stuff)
Liquify…
Pattern Maker…
Artistic
Blur

Gaussian blur
Brush Strokes
Distort
Noise

Useful for getting something form nothing
Pixilate
Render

Clouds
Lens flare
Lighting effects

Sharpen
Unsharp mask

Sketch
Stylize

Emboss
Solarize
Wind

Texture

TYPE FORMAT
Photoshop 6 and 7 added sophisticated type 
and paragraph formatting capabilities similar 
to those in PageMaker or InDesign. Not only 
can users change font and size on the fly 
(without moving into another dialog box), 
but they can change leading, color, character 
width and even position.

LAYER STYLES
In what used to take a dozen or more steps, 
Photoshop 6 and 7 allows a user to do drop 
shadows and bevels with one click. 
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Position statement on
photo manipulation

Given the rapid growth brought about by photo-manipulation software 
and the reliance scholastic journalism programs are placing on them, the 
Journalism Education Association urges students and advisers to follow 
these principles:

Advisers of student media should not make decisions about the suit-
ability or legality of images in question. Instead, advisers should empower 
students to make such decisions and to counsel students to avoid deceptive 
practices in all aspects of publication work.

Advisers should also counsel students to seek professional legal advice in 
all legal and ethical questions.

Students working on publications should consider the following tests 
devised by University of Oregon professors Tom Wheeler and Tim Gleason 
about “whether and how to manipulate, alter or enhance” images:

The viewfinder test—Does the photograph show more than what the 
photographer saw through the viewfinder?

The photo-processing test—A range of technical enhancements and 
corrections on an image after the photo is shot could change the image. Do 
things go beyond what is routinely done in the darkroom to improve image 
quality—cropping, color corrections, lightening or darkening?

The technical credibility test—Is the proposed alteration not technically 
obvious to the readers?

The clear-implausibility test—Is the altered image not obviously false to 
readers?

If any of the above tests can be answered “yes,” JEA urges student jour-
nalists to:
     • not manipulate news photos;
     • not publish the image(s) in question; or
     • clearly label images as photo-illustrations when student editors decide 

they are the best way to support story content.
From the Journalism 

Education Association

Photo ethics policy
 As journalists, we believe the guiding principle of our profession is ac-

curacy. Therefore, we believe it is wrong to alter the content of a photograph 
in any way that deceives the public.

 As photojournalists, we have the responsibility to document society 
and to preserve its images as a matter of historical record. It is clear the 
emerging electronic technologies provide new challenges to the integrity 
of photographic images. This technology enables the manipulation of the 
content of an image in such a way that the change is virtually undetectable. 
In light of this, we, the National Press Photographers Association, reaffirm 
the basis of our ethics: accurate representation is the benchmark of our 
profession.

 We believe photojournalistic guidelines for accuracy currently in use 
should be the criteria for judging what may be done electronically to a 
photograph. Altering the editorial content of a photograph, in any degree, is 
a breach of the ethical standards recognized by the NPPA. 

From the National Press
Photographers Association

This outline was originally written for the Instructors Only 
Summer Workshop of the Association of Texas Photography 
Instructors in 1995. It has been modified to accommodate 
upgrades to the software and is geared towards instructors 
of digital imaging in a photojournalism setting. Consequently, 
not all functions of the software are included.

Interfacing with other
programs

Adobe Illustrator
Macromedia FreeHand
Adobe PageMaker
QuarkXPress

Law and ethics
Photo manipulation

When does a photo become a photo il-
lustration?

When is it never OK to manipulate a 
photo?

Public expects a depiction of reality.


